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About myself – Ambra Sannino
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M.Sc. Electrical Engineering,  1997  
Ph.D. Power Systems, 2000 

2004 – 2018: 
Corporate R&D: Project Manager > Team Manager
R&D / Technology Manager, for FACTS, Substations, 
Product Manager for Power Quality Solutions  

2001-2004: Post-doc > Assistant 
Professor > Associate Professor 

2019 – today: 
Business Director, Power System Analysis 
Head of Department Power Systems, Northern Europe 

IEEE Senior Member 
Member since 1999

Cigré Member 

Board member of 
Kraftkvinnorna

and Power Circle
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A global assurance and risk management company

Ship and offshore
classification and 

advisory

Energy advisory, 
certification, 

verification and 
monitoring

Management system 
certification, 

supply chain and 
product assurance

Software and 
digital solutions

 5% R&D
of annual revenue

 158
years

 100+
countries

 100,000
customers

 12,000
employees
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The world's leading resource of independent 
energy experts and technical advisors
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42 GW
of real-time operational data 
from solar PV, wind and 
storage assets under 
management

170
industry standards, 
guidelines and recommended 
practices, and approx. 30 
joint industry projects per 
year

65%
of offshore pipelines 
designed and installed to 
DNV standards

World 1st 

hydrogen full-scale testing 
facility supporting safety, 
infrastructure and policy

>100
large power utility companies 
trust us as their technical 
advisor

4000 experts
provide local access to global 
best practice delivering safe 
and effective energy systems

24
laboratories and test centres 
including facilities for         
full-scale testing

90+ years
serving the energy industry, 
including the oil and gas, 
wind and solar sectors
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How did we get here? 
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Suite of publications available on
eto.dnv.com
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Final energy demand levels off from 2030
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• Energy demand getting back to pre-Covid levels 

• Final energy demand peaks around 2040, 
slightly above 2021 figures (13%), and remains 
then flat to 2050

• Reduction in energy intensity 

• energy consumed per unit of GDP will reduce by 
2.4%/yr over the next 30 years 

• Energy efficiency achieved via electrification 

• Transport: electric vehicles + hydrogen 

• Buildings: heat pumps 

• Industry: decarbonization by using hydrogen 

Heat pumps EVsHydrogen 
electrolysers

DNV ©

Europe vs Global
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Europe vs Global
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Trends in Power & Energy: Decarbonization 
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Heat pumps

Electric Vehicles

Hydrogen 
electrolysers

INDUSTRY

BUILDINGS

Electricity brings more efficient 
energy use with low climate impact, 

if generated in a green way
TRANSPORT

DEMAND SUPPLY

POWER
GRID

Power grids investment to grow by 50% in the next 10 years
of which 15% in digital infrastructure

Transmission lines will double, distribution > double by 2050
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Multi-terminal HVDC grid benefits

UK as example

• 18% lower lifetime costs

• Significantly lower 
environmental impact

• Significantly lower local and 
social impact

• Improved security of supply

12 Ref: National Grid ESO Offshore Coordination Study, 2020
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HVDC systems 
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• Bespoke projects
• Easier project development

• Single vendor procurement
• Single purpose

• Mature and widely applied

Point-point systems Radial multi-terminal system Meshed multi-terminal system

AC-DC 
converters

HVDC line / 
cable

• Multi-purpose
• Fewer converters

• Lower cost
• Lower footprint
• Lower losses

• Requires compatibility

• Redundant paths
• Increased availability
• Reduced impact on AC grids

• Requires DC protection system

A

B

C

A

B

C

A

B

C

DolWin1 – 800 MW – DC
DolWin2 – 916 MW – DC
DolWin3 – 900 MW – DC
DolWin5 – 900 MW – DC
DolWin6 – 900 MW – DC

BorWin1 – 400 MW – DC
BorWin2 – 800 MW – DC
BorWin3 – 900 MW – DC
BorWin5 – 900 MW – DC

alpha ventus – 62 MW – AC
Riffgat – 113 MW – AC
Nordergründe – 111 MW – AC

SylWin1 – 864 MW – DC
HelWin1 – 576 MW – DC
HelWin2 – 690 MW – DC

Borssele Alpha
Borssele Beta
Hollandse Kust (zuid) Alpha 
Hollandse Kust (zuid) Beta 
Hollandse Kust (noord) 
Hollandse Kust (west) Alpha 
Hollandse Kust (west) Beta 
Hollandse Kust (wet) Gamma 
Ten noorden v.d.Wadden

– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC
– 700 MW – AC

TenneT projects in Germany and The Netherlands

April 6, 2023 C1 - Public Information

2022: 16 connections, total 9.9 GW

2032: + 21 connections, additional 32 GW
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2 GW concept 

• End of March 2022, Tennet awarded 
11 connections for total 23 bnEUR

• based on new 2GW concept 
developed together with the market 

• The 2 GW concept consists of

• Standardized cable 

• Standard platform design

• Standard contract 

• The 2 GW concept is 

• Standardized in design 

• Procured at scale  

• DC grid-ready 

15

Det grønne taktskiftet

ONE sustainable and resilient power system

Total installed power production in Norway 2022 ≈ 38 GW

Norway

+30 GW
by 2040

Europe

~300 GW
by 2040
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Norway – First step 

• Two areas: 

• Utsira Nord, potential 1.5 GW, floating

• Sørlige Nordsjø II, potential 3 GW, fixed 

• Auction for first chunk of SNII opened end of 
March, sites will be awarded in Dec 

• SNII first phase will be a 1500 MW radial link 
to Norway. For the second phase, a hybrid 
interconnector to other countries may be 
considered. 

• Statnett’s analyses show that a hybrid solution 
would be more socioeconomically beneficial 
than a radial link. 

17
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HVDC grids – Opportunities

• Benefits of HVDC grids: 

• Better use of wind resource 

• Better market integration

• Relieve transmission grid congestion 

• Overlay DC grid as backbone of the 2050 European grid

• Coordination to unlock project synergies and realize societal 
benefits

• Standardisation to enable technical compatibility and
interoperability

• Integration with the existing AC grid

18

interoperability 

modularity 

standardization 

expandability 
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Example: Terna’s Hypergrid 

• New Development Plan of Italy’s transmission grid 
unveiled in mid March  

• Investment in the next 10 yrs up by +17% to a total 
of €21bn, of which €11bn for five HVDC backbones

• Power transmission capacity from south to north 
doubles from today’s 16 GW to 30 GW 

• Terna has connection requests for 300GW today

• The plan includes 500kV marine connections and 
extensive use of DCCBs by 2032 

19

Source: Terna

Five new HVDC backbones combined with existing and already planned HVDC links (eg 
Thyrrenian link) create an overlay DC grid (Hypergrid)  

DNV © 18 APRIL 2023

Now Sweden is moving 

• Dramatically increased activity in past few years 

• In 2022, the Swedish government tasked the TSO with 
expanding the transmission into territorial waters

• In the first round, 6 areas have been prioritized. 

• No prior choice of technology, can be AC or DC

20

Source: Svenska kraftnät

Connection inquiries received 
by TSO by end of 2021 
Ca 120 GW offshore wind

Source: Svenska kraftnät

Baltic Sea Conference Sept 2022
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Today’s situation in Sweden

• Generation reduced in the South due to 
decommissioning of nuclear reactors 

• Strong development of wind power (on land) 
concentrated in the North 

• Insufficient transfer capacity North – South, 
leads to price differences >100 times across 
the country (similar in Norway). 

• Huge reinforcement program under way, but 
will take years to build more transmission 
 urgent need for generation in the South

21

Many other EU countries have similar 
congestions issues

Example 12 August 2022
Source: Nordpool

Baltic Sea Conference Sept 2022
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Potential next step?

• No prior choice of technology, can be AC or DC 

• Possibility to create a parallel North-South path 

• Support the existing AC grid with eg additional transfer 
capacity, but also voltage support / inertia  

• Could be expanded into transnational / hybrid 
interconnector 

• Could be prepared for further additions eg on or close 
to Gotland 

• Expandability is key! 

• Note: this is NOT in Svenska kraftnät’s current plan

22 Baltic Sea Conference Sept 2022
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Pilot projects
Full scale demonstrators of feasibility and benefits

23

Radial MT
Half-bridge MMC 
Multi-vendor
Onshore DCCB

Radial MT
Half-bridge 
MMC single-
vendor

Radial MT
Half-bridge MMC 
Multi-vendor
Trans-national MT
Offshore DCCB

OWF

OWF

Standard 
p2p
Half-bridge 
MMC 
single-
vendor

OWF

OWF

OWF

Radial MT
Half-bridge MMC Multi-vendor
Transnational MT
Offshore DCCBs

Hub

Radial MT
Full-bridge MMC 
single-vendor

DNV © 18 APRIL 2023

Pilot projects
Full scale demonstrators of feasibility and benefits
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200 kV 400 MW
Five-terminal radial
Zhoushan system
China

160 kV 240 MW
Three-terminal radial
Na’nao system 
China

320 kV 900 MW 
HVDC Gas insulated switchgear
Borwin 5 & Dolwin 6 projects
Germany

2 GW 525 kV 
HVDC Multi-terminal 
readiness & HVDC GIS
IJmuiden Ver, Netherlands

525 kV 3x2 GW
Meshed offshore grid
Windstrom-Booster & 
Heide HVDC hub
Germany

320 kV 1200 MW
Three-terminal radial 
CMS system, 
Scotland, UK

2013 2021 2023 2032202720252020

500 kV 3 GW
Five terminal meshed
Zhangbei system
China

20332030 203120292015

380 kV 2 GW
Three-terminal FB
ULTRANET, Germany

2014 2016 2017 2018 2019 2022 2024 2026 2028

Radial multi terminal China
Meshed multi 

terminal 
China

Radial multi 
terminal 
Europe

HVDC GIS
Europe

Full-bridge 
converters 

Europe

Standardization 
Modularization 
Coordination 

Europe

Meshed multi-terminal grids & islands Europe

Combination with hydrogen  Europe

Offshore & multi-terminal HVDC  US

North Sea Wind 
Power Hub

EUROBAR



18 April 2023

13

DNV © 18 APRIL 2023

Energy Islands 

• June 2020: DK decides to build 2 energy islands 

• Bornholm energy island: capacity of 3 GW, 

• North Sea energy island: capacity of 3 GW in 2033, and 
10 GW in the longer term.

• TritonLink will transfer offshore wind energy to DK 
and BE via two artificial energy islands

• Studies are ongoing 

• Construction to start in 2026-27, energization in 2031-32

• Energinet also works since 2017 in the NSWPH 
consortium (with Gasunie and TenneT) on offshore 
wind hubs

25

Source: Danish Energy Agency

Source: Energinet

Source: Elia

Initial focus on green electricity with additional production of 
green fuels such as hydrogen or ammonia in the future

Source: Elia

DNV © 18 APRIL 2023

Target Grid 2045

• A network of DC superhighways and 
energy hubs, and a significantly improved 
existing AC grid

• In 2045, DE and NL face more than 
doubling of electricity consumption 

• They will be able to produce approximately 
70 GW of offshore wind energy each 

• to be delivered as efficiently as possible to 
industries and households in NL, DE, and 
other European countries. 

• Look at animation here

26
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Sector coupling / System of systems

27

Heat pumps

Electric Vehicles

Hydrogen 
electrolysers

INDUSTRY

BUILDINGS

Electricity brings more efficient 
energy use with low climate impact, 

if generated in a green way
TRANSPORT

DEMAND SUPPLY

POWER
GRID

ENERGY 
SYSTEM
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Some other things we have not talked about…. 

28

POWER
GRID

ENERGY 
SYSTEM

Demand flexibility

Energy Storage Digitalization

Hydrogen
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www.dnv.com
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State-of-the-art of technology?
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• Converters

• Voltage sourced converters

• 800 kV, 5 GW in operation

• Line commutated converters

• 1,100 kV, 12 GW in operation

• Switchgear

• HVDC circuit breakers

• 500 kV, 25 kA in operation

• HVDC gas insulated switchgear

• 250 kV in operation

• 525 kV qualified

• Cables

• Mass-impregnated paper

• 600 kV, 2.2 GW in operation (PPL)

• 800 kV 

• Extruded polymer

• 525 kV, 2.1 GW qualified

• 640 kV, type tested
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What are the main 
barriers?
• Inadequate cross-jurisdiction coordination

• Incompatible regulatory frameworks 

• Insufficient operational experience

• Lack of standardization 

• Unsolved vendor interoperability issues

• Limited supply chain

• Onshore AC grid constraints

31
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HVDC grids – related collaborations 
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2014 2016 2018 2020 2022 2024

Oct 2014-Sep 2018

Total budget: 62.8 M€
EC contribution: 35.5 M€

39 Partners from 
11 European countries

Apr 2022 – Sep 2023

Total budget: 1M€
EC contribution: 1 M€

7 Partners

Jan 2016 - Dec 2019

Total budget: 42M €

34 Partners from 
11 European countries

Jan 2023 – Apr 2027

Total budget: 69 M€
EC contribution: 50 M€

17 Partners

Oct 2022 – Mar 2026

Total budget: 6.9 M€
EC contribution: 6.5 M€

14 Partners from 
11 European countries

2026

HVDC grids 
feasibility proven
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Summary

• Multi-terminal HVDC transmission grids:

• have significant benefits over multiple point-point links

• already exist  the technology is ready

• are a key enabler of the energy transition

• Pilot projects needed to demonstrate technical feasibility and project benefits

• Cooperation and collaboration across all stakeholder levels needed to achieve:

• Standardisation to enable technical compatibility and interoperability

• Coordination to unlock project synergies and realize societal benefits

• Looking further: combine offshore wind and hydrogen storage in energy island concepts 

33
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TIPS & TRICKS - YOUR USER GUIDE

TEXT STYLES
Use the TAB-key to jump through 
levels. Click ENTER, then TAB to switch 
from one level to the next level

To go back in levels use SHIFT-TAB

Alternatively, Increase and
Decrease list level can be used

Reset slide

Click the Reset menu to reset position, size 
and formatting of the slide placeholders to 
their default settings

SLIDES & LAYOUTS
Click on the menu New Slide in the Home
tab to insert a new slide

Change layout

Click on the arrow next to Layout
to view a dropdown menu of possible slide 
layouts

PICTURES
On slides with pictureplaceholder, click on 
the icon and choose Insert

Crop picture

1. Click Crop to change size or 
focus of the picture

2. If you want to scale the picture, 
hold SHIFT-key down while 
dragging the corners of the picture

HINT: If you delete the picture and 
insert a new one, the picture may 
lie in front of the text or graphic.
If this happens, select the picture, 
right-click and choose Send to Back

HEADER & FOOTER
Do this at the very end to apply the changes 
on all slides

Click on Header and Footer in the Insert tab 
(write the desired text, click date or page 
number from or to)

Click Apply to All or Apply if only used on 
one slide

GRIDLINES
Click the View tab and set tick mark next to 
Guides

HINT: Alt + F9 for quick view of guides

COPY/PASTE 
CONTENT
When copying old content to your new 
presentation, 2 options are available:

1. Best practice: Create a slide in your new 
presentation and copy one piece of content 
at a time (e.g. copy all text from one textbox)

2. Or copy an entire slide into your new 
presentation and then choose a fitting layout. 
Remember to delete the old, wrong layouts 
(go to View > Slidemaster and delete them)

34
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Technology readiness

35

9
Actual system proven & competitive manufacturing

8
System complete and qualified

7
System prototype demonstration

6
Technology demonstrated in industrial environment

5
Technology validated in industrial environment

4
Technology validated in lab

3
Experimental proof of concept

2
Technology concept formulated

1
Basic principles observed

0
Idea

≤ 
52

5 
kV

≤ 
32

0 
kV

≤ 
40

0 
kV

 
HVDC 
XLPE 
cable

≤ 
52

5 
kV

≤ 
32

0 
kV

≤ 
40

0 
kV

 

MMC-VSC
Half-bridge 
converters 

≤ 
32

0 
kV

≤ 
52

5 
kV

HVDC gas 
insulated 

switchgear

HVDC circuit 
breakers

≤ 
52

5 
kV

≤ 
32

0 
kV

≤ 
40

0 
kV

 

MMC-VSC
Full-bridge 
converters 

≤ 
25

0 
kV

≤ 
52

5 
kV

≤ 
32

0 
kV

≤ 
40

0 
kV

 

Note: Excluding Chinese market

Ref: EU project PROMOTioN (with updates)
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What is the difference?

Multiple point-point links

• Allows different technologies and voltage 
levels for each link

• Optimise design & operation of each link

• Avoids project dependencies

• Schedule

• Terminal locations

• Anticipatory investments for expandability

• Simplifies multi-vendor interoperability

• Systems from different vendors coupled at AC 
side guided by AC grid codes

• Proven, accepted technology

Multi-terminal grid

• Fewer converters

• Lower losses

• Lower footprint

• Lower socio-environmental impact

• Lower permitting burden

• Higher availability

• Better utilization

• Multi-purpose use

• Fewer cables (for meshed systems)

• Use redundant paths to satisfy most severe single 
contingency constraints

36
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HVDC grids – Opportunities

• Benefits of HVDC grids: 

• Better use of wind resource 

• Better market integration

• Relieve transmission grid congestion 

• Overlay DC grid as backbone of the 2050 European grid

• Coordination to unlock project synergies and realize societal benefits

• Standardisation to enable technical compatibility and interoperability

• Integration with the AC grid, some aspects to consider 

• Availability vs redundancy

• Protection coordination

• Additional support functionalities 

• Control interactions and other power quality concerns 

37

interoperability 

modularity 

standardization 

expandability 
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MT-HVDC grid as a backbone? 

• A multiterminal, overlay DC grid can become the backbone of the European grid to 2050 

• How will the 2050 grid look like? HVDC grids will evolve organically  need to be expandable 

• How to enable and prepare for expansion? Standardization, modularization, extra space on platforms? 

• Integration of HVDC grid with the AC grid, some aspects to consider

• Availability vs redundancy, how much redundancy is needed? 

• Protection coordination, make use of faster fault clearing in HVDC links? 

• Additional support, eg reactive power, voltage support functionality, inertia  

• Control interactions and other power quality concerns 

• Cooperation across all stakeholder levels needed to achieve 

• Standardisation to enable technical compatibility and interoperability

• Coordination to unlock project synergies and realize societal benefits

38
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Terna’s Hypergrid project

• In March, Terna unveiled its 2023 Development 
Plan of Italy’s transmission grid, totaling €21bn of 
investments in the next 10 yrs, (+17% compared to 
the previous plan)

• The Hypergrid project comprises five new electricity 
'backbones’ (total €11bn investment) that –
combined with Thyrrenian link and existing HVDC 
links – will create an overlay DC grid 

• Double the power transmission capacity from south 
to north from today’s 16 GW to 30 GW 

• Terna has connection requests for 300GW today

• The plan includes 500kV marine connections and 
extensive use of DCCBs by 2032 

39

Source: Terna

Source: Terna

DNV ©

Final energy demand levels off from 2030

40
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Primary energy supply peaks in 2036

41
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The world is electrifying at high speed

42

Heat pumps EVsHydrogen 
electrolysers
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70% of electricity will come from solar and wind

43
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Storage is essential for the inclusion of variable 
renewables in electricity

44
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Hydrogen - late but strong growth: 
5% of global energy demand in 2050

DNV ©

Hydrogen production dominated by 
electrolysis from dedicated renewables

46
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Suite of publications available on 
eto.dnv.com

DNV ©

The share of electricity in the final energy demand mix 
doubles by 2050

48

DNV’s ETO 2022
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Renewables will dominate this shift making up 83% of 
electricity production by 2050

49

DNV’s ETO 2022

DNV ©

Electrification is key to the energy transition 
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• By 2050, the share of electricity has almost 
doubled, from ca 19% to ca 36% 

• Hydrogen from 0 to ca 5% of global demand

• Coal and oil reduce their share

• Use of gas will decline slightly

• Electricity will be generated for >80% by 
renewables, wind and solar combined give 70% 

• Solar+storage grows despite the high price 
compared to solar only 
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A closer look at Europe (1) 
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• Significant reduction of energy demand, already 
started and in 2050 ca 20% lower than today 

• Population stays constant while GDP grows by 
50% and energy use goes down by ca 25% 

• Stronger trend towards electrification + hydrogen 

DNV ©

A closer look at Europe (2) 

52

• Coal and oil reducing drastically in electricity 
generation from 2025 and onwards 

• Natural gas takes longer 

• 50% of the electricity is generated from wind of 
which half from offshore wind 

• Continued strong trend of new installed capacity 
from wind and solar, even steeper from 2040
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Europe vs Global
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Europe vs Global (2)
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Europe vs Global
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Trends in Power & Energy: Decarbonization 
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Heat pumps

Electric Vehicles

Hydrogen 
electrolysers

INDUSTRY

BUILDINGS

Electricity brings more efficient 
energy use with low climate impact, 

if generated in a green way
TRANSPORT

DEMAND SUPPLY

POWER
GRID

ENERGY 
SYSTEM

Power grids investment to grow by 50% in the next 10 years
of which 15% in digital infrastructure

Transmission lines will double, distribution more than double by 2050
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Offshore Wind

• Strong global growth expected

• First MT (radial) VSC-HVDC grids

• Multi-purpose HVDC infrastructure appearing

• Some countries leading the development – with 
“new” ones quickly coming up  

57
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Commercial operation date

HVDC connected offshore wind farms

Global DE UK NL DK US CN

TenneT offshore at a glance

Current offshore transmission capacity
(Germany and the Netherlands)

9,932 MW

total cable length

~ 3,700 km
16 offshore

grid connections

29 TWh
transmission of 

offshore wind energy

Length up to

250 km
per connection

4
interconnectors

58 April 6, 2023 C1 - Public Information
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62 MWAlphaventus (DE)2009
400 MWBorWin1 (DE)2010
113 MWRiffgat (DE)2014
800 MWBorWin2 (DE)2015
800 MWDolWin1 (DE)
864 MWSylWin1 (DE)
576 MWHelWin1 (DE)
690 MWHelWin2 (DE)
916 MWDolWin2 (DE)2016
111 MWNordergründe (DE)2017
900 MWDolWin3 (DE)2018
900 MWBorWin3 (DE)2019
700 MWBorssele Alpha (NL)
700 MWBorssele Beta (NL)2020

Hollandse Kust (zuid)2022
700 MWAlpha (NL)

Hollandse Kust (zuid)
700 MW

9,932 MW

Beta (NL)

16 grid connections2022

In operation Future

900 MWDolWin6 (DE)2023
700 MWHollandse Kust (noord) (NL)
700 MWHollandse Kust (west) Alpha (NL)2024
900 MWDolWin5 (DE)2025
900 MWBorWin5 (DE)
980 MWBorWin6 (DE)2026
700 MWHollandse Kust (west) Beta (NL)

2,000 MWIJmuiden Ver Beta (NL)2028
2,000 MWBalWin3 (DE)2029
2,000 MWBalWin4 (DE)
2,000 MWIJmuiden Ver Alpha (NL)
2,000 MWIJmuiden Ver Gamma (NL)

Ten noorden van de Wadden-2030
700 MWeilanden (NL)

2,000 MWNederwiek 1 (NL)
2,000 MWNederwiek 2 (NL)
2,000 MWLanWin1 (DE)
2,000 MWLanWin2 (DE)
2,000 MWDoordewind 1 (NL)2031
2,000 MWDoordewind 2 (NL)
2,000 MWLanWin4 (DE)
2,000 MW

32,480 MW

LanWin5 (DE)

21 grid connections

North Sea Grid Developments over the years
TenneT Offshore grid connections in overview

C1 - Public Information23 March 20236


